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CLASS-11
th

 (Commerce) 
S.NO. TOPIC PAGE NO 

1. UNIT-1 
TALLY: 
Module 1: Introduction to Financial Accounting 
Accounting Concepts, Basic Computer Knowledge, What is Tally, All Types 
of Books in Tally. 
Module 2: Financial Accounting (Company Info.) 
What is Company Firm?, Company Creation, Company Details, Alter & edit 
in company. 
Module 3: Gateway of Tally- Accounting Info  
What is Account and Ledger, How to create Ledger in Tally, Understand by 
Grouping, Types of Groups 
Module 4: Gateway of Tally- Accounting Voucher 
What is Voucher, Working with All Vouchers, Contra Entry, Purchase Entry, 
Sales Entry, Payment Entry, Receipt Entry, Journal Entry, Balance Sheet , 
Profit & Loss Account. 
Module 5: Inventory  
Introduction to Inventory, Stock Groups , Stock Categories , Stock Item , 
Locations / Go downs , Units of Measure , Price List, Pure Inventory 
Voucher, Entry of Pure Inventory Voucher , Bill of Material, Material 
Transfer, Sale Material, Purchase Material. 
Module 6: Document Printing 
Printing, Printing Configuration for Vouchers, Printing Reports, Printing of 
Inventory Reports. 

 

 UNIT - 2 

Formula and functions in MS- Excel:  
Introduction, Formula, Using Basic Formula, Using Range in formula, 
Edit a Formula, Using Compound Formulas, Using Text formula, 
Operator Precedence, Copy/Paste a Formula, Insert a Function,  
formula(SUM, COUNT, COUNTA), Excel Average Formula Using the + 
and / Operators, Naming a Sheet Tab, Changing color of a sheet tab, 
Functions(Max, Average, Today). 

 

2. UNIT-3    
ADVANCED POWER POINT: 
Introduction, Features, Designing, Scope, Manipulating Slides, 

Inserting Sound Videos, Animations, Graphics Object.  

 

 

After briefing the theory of all the 6 modules their practical will be conducted 

simultaneously    

 

 



UNIT-1 

 

Accounting is the activity or the system of keeping records of transactions of a business 

or any other organizations in monetary terms. It records the money or value for money 

received by or given to different persons or entities from time to time. It enables an 

organization to ascertain facts such as money owed to or by different entities, the assets 

and liabilities of the organization in different forms and the profit or loss made by it 

during specified periods. 

Accounts refer to the complete records created by the accounting system. Also, an 

individual account refers to a specific entity or account head in respect of which separate 

record of accounting transactions is made. 

Tally is a trade name of accounting software maintaining accounts, and for performing 

additional accounting and other analytical operations helpful in management of an 

organization. 

Tally represents a business solution developed by the Tally Solutions Pvt Ltd software 

company whose headquarter is located in Bangalore. Hence, Tally is accounting software 

which is used by small and medium enterprises from different countries all over the 

world. Tally solution easily simplifies the business process and it can be used by 

accountants who have knowledge of English language. 

All the accounting activities, such as financial records of a business, the generation of 

statements concerning the liabilities and assets of a business, all of them are easily 

managed with Tally solution. 

Step by step company creation in Tally  

Company creation in Tally | How to go ahead 

 

http://www.tallynine.com/wp-content/uploads/image_thumb6.png


Now hit Create company button and you will find below screen 

Company creation in Tally | First step to do? 

 

Type legal name of company and its mailing address. 

Note : You may alter name and address at any time latter on you wish so. 

 

 

After address, select your county. Than select Stat 

  

http://www.tallynine.com/wp-content/uploads/image_thumb7.png
http://www.tallynine.com/wp-content/uploads/image_thumb8150x103.png


 

If your office location is in Mumbai from where you have to prepare books of account, 

and your business unit is in Delhi, then you have to select your state as Delhi and not 

Maharashtra. 

Now you have to select method of accounts i.e. Accounts only or Accounts with 

inventory 

If you select accounts only then you will not be able to keep record of inventory. 

 

Further, you have to select period of accounting year. 

Accounting year is a period for which books of accounts are being managed. 

Calendar year is the year starting from 1st January of any year and ends on 31st 

December of the same year. 

Financial year is a year which starts on 1st April of a calendar year and ends on 31st 

March of the subsequent calendar year. 

Company only to comply with the provisions of the companies act in case of newly 

formed company. 

http://www.tallynine.com/wp-content/uploads/image_thumb9.png
http://www.tallynine.com/wp-content/uploads/image_thumb10.png


So any case the financial year from should be the 1st April of the calendar year for which 

you want to start books of account regardless to the fact when the business was started. 

The second selection is starting date of books of account. This is the date of starting your 

books of account. but be careful while selecting this date. 

If you were maintaining your books of account on manual and from 1st April, 2009, you 

have decided to write books in tally then your financial year as well as books beginning 

will start from 1st April, 2009. 

For running business you can not choose any other date then the 1st April of the calendar 

year. 

So, books begin date must be 1st April of the financial year for all business except those 

which start during the middle of a financial year. 

Let’s say your business starts on 1st July, 2009, then the Financial year will be 1st April, 

2009 and books begin from will be 1st July, 2009 

  

Company creation in Tally | The Final set up 

Now, accept the screen by pressing Ctrl +A, to complete company creation in Tally 

 

Company creation in Tally is now about to complete! 

http://www.tallynine.com/wp-content/uploads/image_thumb11.png
http://www.tallynine.com/wp-content/uploads/image_thumb12.png


 

What is Ledger? 

 

A Ledger is the actual account head to which you identify a transaction and must be used 

in all Accounting Vouchers. Without a ledger we cannot record any transactions. 

 

Ex: Purchase, payments, sales, Receipts, etc, all these accounts heads are ledger 

Accounts.  

 

All Ledgers have to be classified into Groups. Classification of Ledgers to the appropriate 

groups is very important. These Groups and Ledgers are classified to Profit & Loss or 

Balance Sheet. The creation and usage of Groups in Tally has been explained earlier. 

Now you will learn how Tally works with Ledgers. 

 

Pre-defined Ledgers in Tally 

 

There are two pre-define ledgers in Tally 

 

1.  Cash: This Ledger is created under the Group Cash-in-hand. You can enter the opening 

balance as on the date of books beginning from. You can also alter the name and even 

delete the Ledger. It helps you to maintain Daily Cash Expenses. 

2.  Profit & Loss Account: This Ledger is created under the Group Primary. Previous year’s 

Profit or Loss is entered as the opening balance for this ledger. The balance entered here 

is treated as the opening profit/loss and shown in the Balance Sheet as opening balance of 

Profit and Loss account in the Liabilities side. You cannot delete this ledger, but you can 

modify the same. 

 

 

 

 

 

 

 

Creating a Ledger 

 

Go to Gateway of Tally  Accounts Info.  Ledgers 

 

 

http://www.tallynine.com/wp-content/uploads/image_thumb13.png


 
 

You can create either Single or Multiple Ledgers.  

Accounts Voucher is the primary document in which the complete details of accounting 

transaction are recorded, like: 

• Payment of Salary to Employees. 

• Withdrawals of Cash from Bank Account. 

 

You make an accounts voucher when you receive or pay money. But there are many 

instances of non cash business transaction that requires a voucher entry, like: 

• Credit Sale 

• Provision of Depriciation for Fixed Assets 

• Appropriation of Profit to Partner’s Capital Accounts 

 

Tally Accounts Voucher Types: 
As per accounting principle, all accounting transactions may be entered in Journal 

Voucher. In fact, in old days, people used only one day book called Journal to record all 

transaction, cash or non-cash. But for sake of convenience, various Types of vouchers 

have evolved, according to nature of transactions. 

The following are the vouchers types:- 

 

• Contra Voucher: - For cash deposit and cash withdrawal from bank i.e. Bank to cash 

or cash to bank deposits we use contra voucher. 

• Payment Voucher: - For bank payment or cash payment to parties or suppliers against 

purchase of goods / services we use payment voucher. 

• Receipt Voucher: - For bank receipts or cash receipts from parties or customers against 

sale of goods / services we use receipt voucher. 

 

• Journal Voucher: - For recording credit expense, credit income or provisional 

adjustment entries we use journal voucher. 

• Sale Voucher: - For cash sale or credit sale transactions we use sale voucher. 

• Purchase Voucher: - For cash purchase or credit purchase transactions we use 

http://1.bp.blogspot.com/-FMzFlZwCbA8/T5I6Ad-rqvI/AAAAAAAAAf0/xiQzf-S7iSw/s1600/image002.jpg


purchase voucher. 

Short commands use in Tally.ERP9 Accounting Software for selecting a voucher type:- 

 

• Press F4 key for contra voucher 

• Press F5 key for payment voucher 

• Press F6 key for Receipt Voucher 

• Press F7 key for Journal voucher 

• Press F8 key for sale voucher 

• Press F9 key for purchase voucher 

 

Voucher entry  

A voucher is the basic recording document. To input any data into Tally, you must use a 

voucher. Inputting data through the voucher entry mode may be called creating a voucher 

or voucher entry. You may create a voucher on-line on Tally and print it for hard copy 

and authentication 

 

Vouchers/Transactions are used to enter/record a transaction in Tally. 

 

Gateway of Tally > Accounting Vouchers 

 

This will open the Accounting Voucher Creation screen 

 

 

 

Inventory operations in Tally 

Stock Creation 
Tally will help us to maintain stock information. If you want create stock in tally, you 

have to create stock Master first, procedure of stock creation as follows: 

 

Step -1 –Stock Group Creation 
 

http://www.selfgrowth.com/software.html
http://tallyguide.blogspot.in/2009/01/voucher-entry.html
http://3.bp.blogspot.com/_X2gPOoMya2Y/SX67ARclytI/AAAAAAAAAV0/MPuZn-fCCYg/s1600-h/voucher+entry+start+screen+tally.jpg


Stock Groups in Inventory are similar to Groups in Accounting Masters. They are helpful 

in the classification of Stock Items. Classification is based on some common behavior. 

Stock Groups enable easy identification and reporting of Stock Items in statements. 

You can group Stock Items under different Stock Groups to reflect their 

classification based on some common functionality. Grouping enables you to locate 

Stock Items easily and report their details in statements.  

 

Stock Group Creation: 
 

 Gate way of Tally 

 Inventory information 

 Stock group 

 Create  

 Type respective Stock group name 

 Select under group as Primary 

 Press CLtr+A 

 

Stock Group View: 

 

 Gate way of Tally 

 Inventory information 

 Stock group 

 Display 

 Select Stock group name  

 Here we can’t make any modification, this is only for show stock group 

Stock group modification: 

 

 Gate way of Tally 

 Inventory information 

 Stock group 

 Alter  

 Select Stock group name 

 Now make changes 

 Press CLtr+A 

 

 

 

 

 

Step 2 - Stock Categories: 

 

Stock Categories offers a parallel classification of Stock Items, this is a optional  

 

Stock Category Creation: 

 

 Press F11  

 Activate maintain Stock Category   

 Gate way of Tally 

 Inventory information 

 Stock Category 

 Create  

 Type respective Stock category 

 Select under group as Primary 



 Press CLtr+A 

 

Stock Category View: 

 

 Gate way of Tally 

 Inventory information 

 Stock Category 

 Display 

 Select stock category name 

 

Stock Category Alter: 

 

 Gate way of Tally 

 Inventory information 

 Stock Category 

 Alter 

 Select stock Category name 

 Make changes  

 Press CLtr+A 

 

Step 3 –Godown Creation : 

 

      GO down is a  place where we can store stocks ,if you have more than one go down in 

your company ,you can use multiple godown option: 

 

Godown Creation: 

 

 Press F11  

 Activate maintain Multiple Go down    

 Gate way of Tally 

 Inventory information 

 Go down  

 Create  

 Type respective go down name 



 Select under group as Primary 

 Press CLtr+A 

 

(Note: if you want to mention godown address, we have to change configuration press –

F12 use address for godown ) 

 

Godown View: 

 

 Gate way of Tally 

 Inventory information 

 Go down  

 Display  

 Select group name 

Godown Alter 

 

Godown Creation: 

 

 Gate way of Tally 



 Inventory information 

 Go down  

 alter  

 Select godown name 

 make changes 

 Press CLtr+A 

 

Step 4 - Unit of measure: 

 

Stock Items are purchased or sold on the basis of quantity. The quantity is 
measured by Units. Hence, it is necessary to create Units of Measure. You need 
to create Units of Measure for all the Stock Items. You can have simple units 
such as numbers, meters, kilograms, and pieces or compound units like box, 
where, say, one box equals ten pieces.\ 
 

Unit of Measure Creation: 

 

 Gate way of Tally 

 Inventory information 

 Unit of measure  

 Select Type (it may be simple or compound ) 

 Type symbol  

 Type Formal name of the Unit  

 Press CLtr+A 

 

Step 5- Stock Item Creation: 

 

Stock Item refers to goods that you manufacture or trade. It is the primary 
inventory entity and the lowest level of information on your inventory. You have to 
create a Stock Item in Tally for each inventory item that you want to account for. 
In other words, you have to create a stock ledger account for each item and Tally 
calls it Stock Item. 
Stock item Creation: 

 

 Gate way of Tally 

 Inventory information 

 Stock item  

 Type stock item name 

 Select appropriate group  

 Select appropriate category 

 Select appropriate go down  

 Select unit measure  

 Type Opening balance, rate  

 

Stock item display 
 Gate way of Tally 

 Inventory information 

 Stock item  

 Select stock item  

 

Exercise: 

 

1.    Create company name as Digital System Company 



2.    Create following stock in Digital System Company 

 

Stock Item Stock group Stock 

Category 

Unit Opening 

balance 

Rate 

Samsung15 

inch 

Monitor 15 inch Nos 10 5,000 

LG 15 inch Monitor 15 inch Nos 20 5,600 

HP 15 inch Monitor 15 inch Nos 10 6,000 

Samsung 

optical  

Mouse Optical Nos 10 750 

Hp optical Mouse Optical  Nos 10 750 

Intel Pentium 

4 

Processor Pentium 4 Nos 10 3,500 

Dual Core  Processor Dual Core Nos 10 4,500 

TVs gold 102 

keys 

Keyboard 102 keys NOs 10 3,400 

HP Laser Printer Laser NOs 10 5,000 

HP inject Printer Inkjet Nos 10 2,500 

 

VOUCHERS 

 

1 Payment Voucher 

 

A document which can be used as proof that a monetary transaction has occurred 

between two parties. In business, a payment voucher can be used for a variety of 

purposes, sometimes taking the place of cash in a transaction, acting as a receipt, or 

indicating that an invoice has been approved for payment. 

Payment voucher is prepared for all payments, made by the business firm directly or 

through its bankers. In all business organizations, mostly the payments are made in 

following manners:- 

1. Payment in cash. 

2. Payment by cheques. 

3. Payment by demand drafts or pay orders. 

4. Payment made directly by bank on behalf of the business clients. 

5. Payment also can be made by third party on behalf of business firm. But, in this 

case, no payment voucher shall be made. For this type of transaction, journal 

voucher shall be prepared. 

RECEIPT VOUCHER 

Receipt voucher is prepared for all the money received by the business firm. Money is 

received in a company for the following reasons:- 

 Cash Sales 

 Payment received from the customers against the dues. 

 Advance payment from customers. 

 Refund of securities. 

 Payment received from creditors against the debit balance lying in their account. 

 Receipt of any type of income i.e. interest, commission, rent etc. 

 Refund of any tax amount from tax authorities. 

http://www.businessdictionary.com/definition/document.html
http://www.businessdictionary.com/definition/proof.html
http://www.businessdictionary.com/definition/monetary.html
http://www.businessdictionary.com/definition/transaction.html
http://www.businessdictionary.com/definition/party.html
http://www.businessdictionary.com/definition/business.html
http://www.businessdictionary.com/definition/payment.html
http://www.businessdictionary.com/definition/cash.html
http://www.businessdictionary.com/definition/acting.html
http://www.businessdictionary.com/definition/receipt.html
http://www.businessdictionary.com/definition/invoice.html
http://www.letslearnaccounting.com/voucher
http://www.letslearnaccounting.com/journal-voucher
http://www.letslearnaccounting.com/journal-voucher
http://www.letslearnaccounting.com/journal-voucher
http://www.letslearnaccounting.com/receipt
http://www.letslearnaccounting.com/voucher
http://www.letslearnaccounting.com/company


 Any other receipts. 

CONTRA VOUCHER 

Contra voucher is prepared in the following types of transactions:- 

1. When cash is withdrawn from the bank 

2. When cash is deposited in to bank 

3. When the amount is transferred from one bank to other bank of the same 

company. 

 

Journal Voucher 

Journal voucher entry mode is a special voucher mode in Tally where we can pass 

almost all types of accounting transactions. However, there are separate voucher mode 

for each type of transactions are available in Tally such as- Contra mode for Cash and 

Bank transaction, Payment mode for all Cash and Cheque payments, Receipt mode for 

all Cash and Cheque receipts, Purchase mode, Sales mode, Purchase Return mode, Sales 

Return mode and so on. All these transactions can also be pass through one single 

voucher mode that is Journal Voucher mode. If you do not want to change voucher 

mode for each type of transaction then just stay on Journal voucher mode and pass each 

transaction right from Journal mode. In this article, you’ll get a clear idea on what is 

Journal Voucher mode in Tally and how to pass journal voucher entry in tally. 

 

As we said, the journal voucher mode is a special voucher mode where we can pass any 

types of transactions, actually all accounting transactions where one ledge has to be debit 

and other has to be credit. If you have little bit of Debit/Credit idea and able to find out 

debit and credit ledgers from a transaction then you can pass any transaction in Tally 

Journal mode. Nevertheless, we basically used to pass some adjustment entries in 

Journal voucher mode such as- Discount given to Debtors, Discount received from 

Creditor, Bad Debts, Depreciation and so on. Check out an example from below: 

 

Suppose, you have a Debtor (ABC Co) having due balance of Rs.15000 and you 

received a Cheque of Rs.9500 from the Debtor against their dues and later you  

provided Discount of Rs.500 to the Debtor. So, here you can pass the receipt of Cheque 

entry in Receipt mode and for the Discount you can use the Journal mode where Discount 

Allowed ledger will be debit by Rs.500 and ABC Co will be  

 

credit by Rs.500. 

For Discount: 

 

Dr/By  Discount Allowed A/c------------- Rs.500 

Cr/To  ABC Co A/c---------------------- Rs.500 

Illustration: 

M/s XYZ Limited purchased stationery items form M/s Prince Stationers as per details 

given below:- 

BILL NO. 105 

BILL DATE 31.03.12 

http://www.letslearnaccounting.com/voucher
http://www.letslearnaccounting.com/company


AMOUNT 5250/= 

How shall you enter the above bill in tally program in the books of M/s XYZ Limited? 

 

Solution: 

First of all, Journal Voucher shall be prepared for the above transaction because the 

stationery is not a trading item and the stationery is purchased on credit also. The entry 

will be prepared as follows:- 

M/S XYZ LIMITED 

JOURNAL VOUCHER 

DATE: 31.03.12 

PARTICULARS AMOUNTIN 

RUPEES 

DEBIT: PRINTING & STATIONERY EXPENSES A/C 5250/= 

   

 TOTAL 5250/= 

   

CREDIT: M/S PRINCE PRINTERS 5250/= 

 TOTAL 5250/= 

(BEING STATIONERY PURCHASED FROM M/S PRINCE PRINTERS AS 

PER THEIR BILL NO. 105 DATE 31.03.12 ENCLOSED) 

 

Now, we shall enter above Purchase Voucher in tally as under: 

 Open Tally program. 

 Select your Company. In our case, we shall select M/s XYZ Limited. 

 Select ‘’Accounting Vouchers’ under ‘Gateway of Tally’ 

 Now, the following screen will appear:- 

http://www.letslearnaccounting.com/journal-voucher
http://www.letslearnaccounting.com/voucher
http://www.letslearnaccounting.com/purchase-voucher
http://www.letslearnaccounting.com/company


 
                  

  Just read the items written on screen with a concentration. Reply of your all   

 question relating to voucher entry is available here. 

 You want to enter a Journal Voucher. See in right side. There are lots options 

available. One of those options is ‘F7 – Journal’. 

 Select this icon with the help of mouse or press ‘F7 key’. 

 Now, select date icon or press’F2’ key. 

 A box will show ‘Voucher Date’ 

 Write the date of voucher here i.e. 31.03.12 then press ‘Enter’ key. 

 Now a blank form will appear. You have to fill up the details as required in that 

form. 

 First, in Dr. Particular Column, you have to write Printing & Stationery Expenses 

A/c. The moment you type ‘ M’ a list of account heads started with alphabet ‘P’ 

shall appear. You have to select ‘Printing & Stationery Expenses A/c’ out of that 

list. 

 In Debit amount column write 5250 then press ‘Enter, key. 

 In Cr. Column press ‘Enter’ key. 

 In Particulars press ‘P’ and select ‘Prince Printers’ out of the list given in right 

side. 

 In Credit amount write 5250/= and press ‘Enter’ key. 

 In narration column write any narration which you think fit then press ‘Enter key’ 

 Now the screen will be as under 

http://www.letslearnaccounting.com/account-heads
http://www.letslearnaccounting.com/wp-content/uploads/2012/10/journal-1.jpg


  

 Finally, Tally asks you ‘Yes’ or ‘No’. Here, you just stop and check that every detail 

is correct. If there is any mistake then press ’N’ key otherwise press ‘Y’ or press 

‘Enter’ key. 

 After you press ‘Y’, and all details vanish from the screen and a new voucher appears 

then you can say that your voucher is entered and saved. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.letslearnaccounting.com/wp-content/uploads/2012/10/journal-vr.-2.jpg


Purchase Voucher 

When a company buys goods on credit or cash, Purchase voucher is used to record all the 

Purchase transactions of the company. 

To pass a Purchase Voucher: 

Go to Gateway of Tally > Accounting Vouchers 

 Click on F9:Purchase on the Button Bar or press F9. 

For example, if you are purchasing goods from Supplier A for a value of Rs. 10000/- 

a) Debit Purchase Account 

b) Credit Party Account 

Illustration: 

M/s XYZ Limited purchased goods from M/s Morning Place as per details given below:- 

BILL NO. 121 

BILL DATE 10.04.12 

LOCAL PURCHASE 5% TAXABLE RS.10000/= 

INPUT VAT @ 5% RS. 500/= 

TOTAL BILL VALUE RS.10500/= 

How shall you enter the above bill in tally program in the books of M/s XYZ Limited? 

Solution: 

First of all, Purchase Voucher shall be prepared for the above transaction as below: 

M/S XYZ LIMITED 

PURCHASE VOUCHER 

DATE: 10.04.12 

PARTICULARS AMOUNTIN 

RUPEES 

DEBIT: LOCAL PURCHSE 5% TAXABLE A/C 10000/= 

 INPUT VAT @ 5% A/C 500/= 

 TOTAL 10500/= 

   

CREDIT: M/S MORNING PLACE 10500/= 

 TOTAL 10500/= 

(BEING GOODS PURCHASED FROM M/S MORNING PLACE AS PER THEIR 

BILL NO. 121 DATED 10.04.12 ENCLOSED 

Now, we shall enter above Purchase Voucher in tally as under: 

 Open Tally program. 

 Select your Company. In our case, we shall select M/s XYZ Limited. 

http://www.letslearnaccounting.com/purchase-voucher
http://www.letslearnaccounting.com/voucher
http://www.letslearnaccounting.com/company


 Select ‘’Accounting Vouchers’ under ‘Gateway of Tally’ 

 Now, the following screen will appear:- 

 

 

Just read the items written on screen with a concentration. Reply of your all question 

relating to voucher entry is available here. 

 You want to enter a purchase voucher. See in right side. There are lots options 

available. One of those options is ‘F9 – Purchase’. 

 Select this icon with the help of mouse or press ‘F9 key’. 

 Select the icon ‘As Voucher’. You can enter the bill under ‘As Invoice’ also. But 

it needs lot of practice. For beginner to enter the voucher under ‘As Voucher’ is 

advisable. 

 Now, select date icon or press’F2’ key. 

 A box will show ‘Voucher Date’ 

 Write the date of voucher here i.e. 10.04.2011 then press ‘Enter’ key. 

 Now a blank form will appear. You have to fill up the details as required in that 

form. 

 First, in Cr. Particular Column write Morning Place. The moment you type ‘ M’ a 

list of account heads started with alphabet ‘M’ shall appear. You have select 

‘Morning Place’ out of that list. 

 In Credit amount column write 10500 then press ‘Enter, key. 

 In Dr. Column press ‘Enter’ key. 

 In Particulars press ‘L’ and select ‘Local Purchase @ 5% taxable’ out of the list 

given in right side. 

 In Debit amount write 10000 and press ‘Enter’ key. 

 Again in Dr. Column press enter and in particular column select Input Vat @ 5% 

out of the list and in Debit amount write 500 

 In narration column write any narration which you think fit then press ‘Enter key’ 

 Now the screen will be as under 

http://www.letslearnaccounting.com/invoice-or-bill
http://www.letslearnaccounting.com/account-heads
http://www.letslearnaccounting.com/wp-content/uploads/2012/10/PURCHASE-1.jpg


 

 Finally, Tally asks you ‘Yes’ or ‘No’. Here, you just stop and check that every 

detail is correct. If there is any mistake then press ’N’ key otherwise press ‘Y’ or 

press ‘Enter’ key. 

 After you press ‘Y’, and all details vanish from the screen and a new voucher 

appears then you can say that your voucher is entered and saved. 

Illustration: 

M/s XYZ Limited purchased goods from M/s Morning Place as per details given below:- 

BILL NO. 121 

BILL DATE 10.04.12 

LOCAL PURCHASE 5% TAXABLE RS.10000/= 

INPUT VAT @ 5% RS. 500/= 

TOTAL BILL VALUE RS.10500/= 

 

How shall you enter the above bill in tally program in the books of M/s XYZ Limited? 

Solution: 

First of all, Purchase Voucher shall be prepared for the above transaction as below: 

 M/S XYZ LIMITED 

PURCHASE VOUCHER 

DATE: 10.04.12 

PARTICULARS AMOUNTIN 

http://www.letslearnaccounting.com/purchase-voucher
http://www.letslearnaccounting.com/voucher
http://www.letslearnaccounting.com/wp-content/uploads/2012/10/PURCHASE-2.jpg


RUPEES 

DEBIT: LOCAL PURCHSE 5% TAXABLE A/C 10000/= 

 INPUT VAT @ 5% A/C 500/= 

 TOTAL 10500/= 

   

CREDIT: M/S MORNING PLACE 10500/= 

 TOTAL 10500/= 

(BEING GOODS PURCHASED FROM M/S MORNING PLACE AS PER THEIR 

BILL NO. 121 DATED 10.04.12 ENCLOSED 

Now, we shall enter above Purchase Voucher in tally as under: 

 Open Tally program. 

 Select your Company. In our case, we shall select M/s XYZ Limited. 

 Select ‘’Accounting Vouchers’ under ‘Gateway of Tally’ 

 Now, the following screen will appear:- 

Just read the items written on screen with a concentration. Reply of your all question 

relating to voucher entry is available here. 

 You want to enter a purchase voucher. See in right side. There are lots options 

available. One of those options is ‘F9 – Purchase’. 

 Select this icon with the help of mouse or press ‘F9 key’. 

 Select the icon ‘As Voucher’. You can enter the bill under ‘As Invoice’ also. But 

it needs lot of practice. For beginner to enter the voucher under ‘As Voucher’ is 

advisable. 

 Now, select date icon or press’F2’ key. 

 A box will show ‘Voucher Date’ 

 Write the date of voucher here i.e. 10.04.2011 then press ‘Enter’ key. 

http://www.letslearnaccounting.com/company
http://www.letslearnaccounting.com/invoice-or-bill
http://www.letslearnaccounting.com/wp-content/uploads/2012/10/PURCHASE-1.jpg


 Now a blank form will appear. You have to fill up the details as required in that 

form. 

 First, in Cr. Particular Column write Morning Place. The moment you type ‘ M’ a 

list of account heads started with alphabet ‘M’ shall appear. You have select 

‘Morning Place’ out of that list. 

 In Credit amount column write 10500 then press ‘Enter, key. 

 In Dr. Column press ‘Enter’ key. 

 In Particulars press ‘L’ and select ‘Local Purchase @ 5% taxable’ out of the list 

given in right side. 

 In Debit amount write 10000 and press ‘Enter’ key. 

 Again in Dr. Column press enter and in particular column select Input Vat @ 5% 

out of the list and in Debit amount write 500 

 In narration column write any narration which you think fit then press ‘Enter key’ 

 Now the screen will be as under 

 

 Finally, Tally asks you ‘Yes’ or ‘No’. Here, you just stop and check that every detail 

is correct. If there is any mistake then press ’N’ key otherwise press ‘Y’ or press 

‘Enter’ key. 

 After you press ‘Y’, and all details vanish from the screen and a new voucher appears 

then you can say that your voucher is entered and saved. 
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Sale Voucher 

When a company sells goods on credit or cash, Sales voucher is used to record all the 

Sales transactions of the company. 

To pass a Sales Voucher: 

Go to Gateway of Tally > Accounting Vouchers 

 Click on F8:Sales on the Button Bar or press F8. 

For example, if you are selling goods to Debtor A for a value of Rs. 10000/- 

a) Debit Customer’s Account 

b) Credit Sales Account 

Home > Tally > HOW TO ENTER SALES VOUCHER IN TALLY  

HOW TO ENTER SALES VOUCHER IN TALLY 

 ENTRY OF SAlES VOUCHERS  

Tally 

Entry of sales is done in tally in two ways:- 

1)  As Voucher – It means that bill is not prepared in tally package. The sale bill is made 

either made manually or in some other software. The accountant prepares the voucher 

with the help of sales bill then he enters the voucher tally accounting software. 

2)  As Invoice – It means that invoice is to be generated in tally software and no separate 

voucher is to be prepared for the same. 

A) Entry of Sales ‘AS VOUCHER’ 

Illustration: 

How will you enter the following Sales Voucher in tally program in the books of M/s 

XYZ Limited:- 

Date Particulars Amount 

(In Rupees) 

31.03.12 Goods sold to M/s Gift House vide sales invoice number 

1  as details given below:- 

21000 

 Local Sales 20000 

 Local Sales Tax 1000 

Solution: 

We shall enter this bill as ‘Sale Voucher’ 
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Following entries shall be made for above transactions:- 

Date: 31.03.2012 

Debit Gift House                 Rs.21000/= 

Credit: Local Sales Account                                    Rs.20000/= 

Credit: Local Sales Tax                                           Rs.1000/= 

(Being goods sold to M/s Gift House as per our invoice number 1100 enclosed) 

 

Note:  In above example, we have presumed that the sales bills are not created through 

tally package. We are just doing the entry of sale bill. ‘Sales Voucher’. 

Now, we shall enter above Sales Vouchers in tally as under: 

 Open Tally program. 

 Select your Company. In our case, we shall select M/s XYZ Limited. 

 Select ‘’Accounting Vouchers’ under ‘Gateway of Tally’ 

 Now, the following screen will appear:- 
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 Just read all the items written on screen with a concentration. Answers of your all 

questions relating to voucher entry is available here. 

 Presently, you want to enter a receipt voucher. See in right side. There are lots of 

options available. One of those options is ‘F8 – Sales’. Select this icon with the 

help of mouse or press ‘F8 key’. 

 Select ‘As Voucher’ 

 Now, select date icon or press’F2’ key. 

 A box will show ‘Voucher Date’ 

 Write the date of voucher here i.e. 31.03.2012 then press ‘Enter’ key. 

 Now a blank form will appear. You have to fill up the details as required in that 

form. 

 In Ref., write any thing as required by your management or just press ‘Enter’ key. 

 First, in Dr. Particular Column write Gift House. The moment you type ‘G’ a list 

of account heads started with alphabet ‘G’ shall appear. You have select ‘Gift 

House’ out of that list. 

 In credit amount column write 21000 then press ‘Enter, key. 

 In Dr. Particulars press ‘L’ and select ‘Local Sales Account’ out of the list given 

in right side. 

 In Credit amount write 20000 and press ‘Enter’ key. 

 Now, in Cr. column press ‘Enter’ 

 In Credit Particulars press ‘L’ and select ‘Local Sales Tax Account’ out of the list 

given in right hand side. 

 In Credit Amount write 1000. 

 In narration column write any narration which you think fit then press ‘Enter key’. 

 Now the screen will be as under. 
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Finally, Tally asks you ‘Yes’ or ‘No’. Here, you just stop for a while and check 

that every detail is correct. If there is any mistake then press ’N’ key otherwise 

press ‘Y’ or press ‘Enter’ key. 

 After you press ‘Y’, and all details vanish from the screen and a new voucher 

appears then you can say that your voucher is entered and saved. After it you can 

enter another voucher in same way. 

Balance Sheet 

A Balance Sheet is a financial statement that reports a firm's financial position at a 

specific time. The term balance sheet implies that a report shows the balance between 

two figures. It shows a balance between the assets and liabilities of a firm and the owner's 

funds. The fundamental accounting equation applicable is therefore, Assets = Liabilities 

+ Owner's Equity. 

To view the Balance Sheet: 

Go to Gateway of Tally > Balance Sheet 
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Press F12: Configuration and set the required parameters to display the Balance Sheet 

according to your preferences. 

Note: Balance Sheet gets updated instantly with every transaction voucher that is entered 

and saved. You can view additional information or toggle to another report using the 

options available in the Button Bar. 

Some of the Button Bar options are 

 Select F1:Detailed/Condensed to explode the summarized information. 

 Change the date of the Balance Sheet using F2: Period. 

 View different effect of different Stock Valuations on the Balance Sheet. 

 Add  up new columns to 

 Display the Balance Sheet for a different date to compare with current one 

 Display the Balance Sheet of Another Company when more than One Company is 

opened 

 Display the Balance Sheet in a different currency 

 Display the Budget figures and analyze the variances 

Profit and Loss Account or Income Statement is a periodic statement, which shows the 

net result of business operations for a specified period. All the expenses incurred and 

incomes earned during the reporting period are recorded in the Profit and Loss account or 

Income and Expenditure account. 



The profit and loss account in Tally.ERP 9 displays the information based on the default 

primary groups. It is updated instantly with every transaction/ voucher that is entered and 

saved. No special processing is required to produce a profit and loss account in 

Tally.ERP 9. 

To view the Profit & Loss Account of ABC Company, 

Go to Gateway of Tally > Profit & Loss A/c 

 Click F1: Detailed, to view the Profit & Loss Account in detailed format. 

The Profit & Loss Account is displayed as shown: 

 

The Profit & Loss account is generated and updated immediately from the date of 

opening of books till the date of last entry 

 

 

Practice Exercise: 

 

According to syllabus 

                                                            

 

 

 

 

 

 
 



UNIT-2 

 
 1.1 A.INTRODUCTION 
Spreadsheet software is widely used in offices, business and schools. What makes 
spreadsheets so popular is their ability to perform calculations based on the data stored 
in them. For example, in offices, spreadsheet software is widely used for storing 
financial data. This data can be used for calculating profit and loss, average sales, and 
Balance sheet etc. We have use the spreadsheet in school to calculate average Result 
sheets, marks, grades of students. Another important feature of spreadsheet software is 
its ability to recalculate the values automatically if the source data changes. 
MS Excel is spreadsheet software that is used for storing, organizing and manipulating 
data in rows and columns. In MS – Excel you can perform complex mathematical 
calculations on data. It also allows you to represent data pictorially in the form of charts 
for better understanding and analysis. MS – Excel comes as a part of MS Office package.  

 
A rectangle grid for data entry 

The various spreadsheet software available in the market include MS – Excel, Quattro 
Pro , Open Office Calc. and Lotus 1-2-3 of these, Microsoft Excel is the most popular 
spreadsheet application. 
Application of spreadsheets: 

 Annual reports of business firms 

 Invoices or bills 

 Tender evaluation 

 Banking 

 Inventory control 

 Budgets 

 Payrolls 

 Scientific calculation 

 And many more 

 
 



STARTING MICROSOFT EXCEL: 
 
Clicking Start  Programs  Microsoft Excel as shown in figure 
 

  
 
B. IT’S COMPONENTS: 
Microsoft Office applications, the Excel window has the following components are: 
1. Title Bar: Same like any other window, Excel has a title bar which shows the 

application name along with the file in name. 

2. Microsoft Office Button: This button is located at the excel window, which provides 

access to the basic file Copy, Open, Save, Save As, Print etc. 

3. Formula Bar: This component is an important part of Excel just below the ribbon, is 

used to enter formulas for perform Logical operation. 

4. Quick Access Toolbar: This toolbar is present on the providing quick access to the 

frequently used excel function undo and redo. You can change these default functions 

as per. 

5. Ribbon: All the Excel commands are accessed from the organized as groups under the 

various tabs. The common the form of icons or buttons. 

6. Name Box: This is present towards the left side of form to name or locate a specific 

cell in the worksheet. 

7. Sheet Tab: Located at the bottom of Excel worksheet, used the worksheets. 

8. Status Bar: It shows the status of the worksheet in use along with some useful figures 

while working in the spreadsheet.  



 

            

 
 
The following components are specific to an Excel window: 
 
1. WORKBOOK:  Excel is a spreadsheet program a program designed to work with 
numbers (as opposed to a word processor, such as Word, which is designed to work 
with words). A workbook is an Excel file that contains one or more worksheets. By 
default, a new Excel workbook will contain three worksheets. When you save an Excel 
worksheet, you are actually saving a workbook. Alternatively, you can use Ctrl + N 
keyboard shortcut to start a new workbook. A blank workbook with Sheet1 as the 
current or active worksheet open in excel window. 



 
2. WORKSHEETS: A worksheet is a collection of cells where you keep and manipulate 
the data. It is a work area made up of horizontal rows and vertical columns wherein you 
enter and work with data. When you start Excel by default, each Excel workbook 
contains three worksheets. You can add more worksheets as and when required. An 
Excel worksheet contains 16,384 columns and 1,048576 rows. 
 
CREATING A NEW WORKBOOK:  
Excel file or document is known as workbook which has multiple sheets in it called 
Worksheets. So whenever a new file in Excel is created a new workbook is opened along 
with the blank worksheets.  
To start with a new workbook: 
 
1. Click the MS Office button. 

2. Select New option from the menu that appears. 

3. A New Workbook, dialog box will appear as shown in figure. 

4. Select Blank Workbook option from the Blank and recent section. 

5. Click Create button. 

  
Entering Data:  
Excel can take numeric as well as text data or level for numeric data. We can also put 
cell dependent formulas. There are three different types of data that can go into the 
cells. 
 



Types of data: There generally three types of data can be entered in a worksheet. 
They are Text, Number, & Logical. Error is sometimes displayed by the wrong entry of 
data or formula. 
 
Number: 
In Excel the basic Data type are numbers because Excel is mainly used for manipulation 
of numeric data. Numbers are values that can be calculated. They can consist of the 
numerals 0 through 9, with a decimal point (a period) as a separator for decimal places 
and with commas as separator for decimal places and with commas as separators for 
thousands. 
Numbers can start with dollar sign ($) or other currency symbol, or with a + and – sign. 
Following are some of the important things to understand about the way excel treats 
numbers. 
 
 

 Numbers can be formatted in many ways. You may display numbers using 
commas, scientific notation or one of the built-in numeric formats. 

 Date and time are numbers, but with special formatting. 

 Excel can automatically guess the ‘meaning’ of numeric data and format it 
accordingly. If you enter 3-5 as a text string, Excel will automatically interpret it 
as a date and displays 5 March. 

 NOTE:- Excel interprets a number as a date only if it is entered in American date 
format such as mm-dd-yy i.e. month-date-year and not in Indian format i.e. dd-
mm-yy. 

 When an unformatted number does not fit in a cell, 
it is displayed in scientific notation. 

 When a formatted number does not fit in a cell, 
number signs (####) are displayed. 

 
Dates: 
Excel handles dates as serial numbers, which represent the 
number of days elapsed since 1/1/1990, which is a serial 
number 1(e.g. 31/1/1990 is serial number 31. The benefit 
of a serial number date is that Excel can perform 
calculation on dates easily-to sort 1/2/1997, 2/3/1997 and 
3/3/1997 into reverse order, excel simply works the date 
in serial order. 
It has two benefits: 

 First, Excel handles the serial numbers in the background, so you don’t have to 
worry about them. 

 Second, if you enter a date in one of the four formats shown below, Excel will 
automatically identify it as date, store it as serial number, and represent it to you 
as a Numeric data formatted in the way you choose. 

Date Format  Example 
MM/DD/YY  9/3/96 or 09/03/96 
MMM-YY  Sep-96 
DD-MMM-YY  03-Sep-96 
DD-MMM  03-sep 
                                                                                           
                                                                                          Figure: Numeric data 



Excel uses slashes when displaying dates that need them, but you can use hyphens 
when entering dates-for example both 26-4-2007 and 26/04/2007 will be stored 
correctly. 
 
TIME 
Excel uses serial number for time as well, representing 24 hours of the day as values 
between o and 1. For example, 6 AM is 0.25, 12 noon is 0.5, 6 PM is 0.75 and so on. You 
can enter time in the formats listed below; specify AM or PM if you don’t want Excel to 
use 24 hour format. 
 
Time Format  Example 
HH:MM  10:15 
HH:MM:SS 22:15:17 
HH:MM AM/PM 10:15 PM 
HH:MM:SS AM/PM 10:15:17 PM 
 
You can combine the date and time values to refer to a given time on a given day : for 
example, 6 PM on December 25, 1996 would be 35424. 75 Enter these date and time 
values in the following formats: 
 
Date and Time Format Example 
MM/DD/YY HH:MM  9/3/07/ 10:15 (AM/PM optional) 
HH:MM MM/DD/YY  22:15 9-3-07 
 
Formulas 
Formulas are mathematical formulas telling Excel to perform calculations on data in 
cells. For example, to add data in the cells A1, B2, and C3 and display the result in cell 
D4, you would enter the formula +A1 +B2 + C3 in cells D4. We will look at formulas in 
detail in next chapter. 
 
Text 
Excel considers any data that it does not recognize as a number, date, time or formula 
to be text. In simpler terms it means that data containing letters will be treated as text. 
Texts too long for the cell it is in will be displayed in the cell to the right if they are 
empty; otherwise, only the part that fits in the cell will be displayed, though all the text 
will be stored. 
 
Note: To see the whole contents of a cell whose contents cannot be displayed in a cell, 
make it active by clicking on it; Excel will display the contents in the reference area. 
Text entry 
Text includes any combination of letters, number and special characters. 

 A cell can contain up to 255 characters. 

 If the width of the column is less than that of the input text string, the display 
will extend over neighboring cells. However, if the neighboring cells are occupied 
only the display is truncated and not the text in it. 

 
Entering data into cells: 
To enter data in the active cell, type it in. As you start typing the first character, the data 
will start appearing in both the cell and in the reference area, which will display a Cancel 
button, an Enter button, and an Edit Formula button. 



After you finish typing, you can press Enter, one of the arrow keys (, 
Enter button, or click in other cell with the mouse to enter the entry in the cell. Excel will 
enter the data and will hide the Cancel and Enter buttons that were in the reference 
area. If you pressed one of the arrow key to enter the information, Excel will move the 
active cell to the cell in the direction of the arrow key. 
Now move to the next cell and enter information as appropriate. 
Knowledge Key 
The first version of Excel was released for the Mac in 1985 and the first Windows 
version (numbered 2.0 to line-up with the Mac and bundled with a run-time Windows 
environment) was released in November 1987. Lotus was slow to bring 1-2-3 to Window 
and by 1988 Excel had started to outsell 1-2-3 and helped Microsoft achieve the position 
of leading PC software developer. 
   
SAVING A WORKBOOK: 
We have entered the data in different worksheet of a workbook. All the data are saved 
together a single workbook. 
To save the workbook: 

 Click MS Office button and choose Save As option in the expanded list. Save As 

dialog box will appear as shown in figure. 

 Choose the location where file is to be saved. 

 Enter suitable file name in the File Name box. 

 Click the Save button. 

Alternatively, we can also use save button or Ctrl + S keyboard shortcut to save your file. 
Excel workbook get saved with extension .xlsx and the default workbook name i.e. 
Book1 will get replaced with the name given by you. 
 
C. EXCEL WORKSHEETS:  
Worksheets are the individual pages of a workbook. Data in the window entered in 
these workbooks. By default, a new workbook has 3 worksheets but we can always add 
to delete them as per our needs. We can also data default sheet name i.e. sheet 1, sheet 
2… According to the data stored. We have learned to perform some of the worksheet 
related functions in Excel. 
 
Adding new worksheets:  
If you want to have more than 3 worksheets which are already there in the workbook, 
you can do that like this: 

 Click and select the sheet using sheet tab before which you want to insert new 
sheet. 

 Right click on it and choose Insert option from the shortcut menu. Insert dialog 
box will appear as shown in figure. 

 From the General tab in the dialog box, select Worksheet icon and click OK 
button to get a new blank worksheet in the workbook. 

 



 
 
D. DIFFERENCE BETWEEN WORKBOOK AND WORKSHEET 
1. A workbook is a file that stores the entered related data; a worksheet is a page of the 
workbook on which all the data is held. 
2. A workbook defines the data of the worksheets; the worksheets allow for the data to 
be manipulated for specific purposes. 
In Microsoft Excel, a workbook is simply an Excel file that stores entered related data. 
Workbooks are capable of holding an almost infinite number of worksheets, depending 
on the size and the relevance of the data. It is, essentially, a book filled with the data 
from multiple worksheets. Workbooks are usually labeled by the data which is on each 
worksheet – if all the pages of the workbook hold the same type of data, that workbook 
will be named for the relevant data that it holds. 
In Excel, a worksheet is an amalgamation of a number of cells that hold data pertaining 
to a certain piece of information. It is also known as a spreadsheet. A user is able to 
enter, modify, and manipulate the data that is entered in the spreadsheet. With a 
spreadsheet, a user is essentially entering information onto a page of a workbook. By 
default, each workbook automatically contains three worksheets.  
 
A worksheet, then, is nothing more than a page in the workbook. Each page is filled with 
a specific amount of data. Within a worksheet, the data can be manipulated to create 
charts, graphs, or arrays that visually project the main purpose of the data that was 
initially entered. The worksheet is what defines what the workbook is – without the 
worksheets the workbook would be without form or purpose. The worksheets are what 
make the workbook what it is, and holds all the data for the workbook. 
 
E. EDITING A WORK SHEET/ WORKBOOK: 
Data entered in the worksheet needs to be updated time to time which in the change in 
data value, copying or moving the cell contents, etc. 
So let us learn some powerful editing features of Excel which makes worksheet a useful 
tool for organizing data in it. 
Modifying Cell Contents 
Data Entered in a cell can be modified or replaced as needed. To modify the existing 
value. 

 Click and select the cell whose entry is to be modified. 

 Press F2 function key on the keyboard or Double click the cell to be modified.    
             



 
 A cursor will appear inside the selected cell. 

 Make necessary changes and press Enter key to store the new entry. 
Replacing the Cell Contents: 
 

 Select the cell with existing entry which has to be replaced. 

 Enter the new cell value and press Entry key. 

 The newly entered contents will replace the existing entry. 
 
Deleting Cell Contents: 
 

 Select the Cell(s) whose entry has to be removed. 

 Click Clear ( ) Option in the Editing group on the Home Tab. 
Alternatively we can press the Delete key after selecting the cell(s) whose entry is to be 
cleared. 
F. Formulas in Excel: 
Definition: Formula is a mathematical expression made up of operators and operands 
which is used to perform calculation in Excel worksheet. 
In excel offers various built in functions and the user defined formulas to perform 
mathematical calculations or statistical analysis in the worksheet. Automatic calculation 
is the major advantage of electronic spreadsheet which updates the results as and when 
the values used in the formulas are updated. Excel supports mathematical operators to 
create user defined formulas which are evaluated as per their priority in the expression. 
The Operators are: 
 

Math Operator Definition 

+ Addition 

- Subtraction, 

* Multiplication 

/ Division 

% Percent Exponents 

 



These Operators are used along with the operands that can be the constants or cell 
references of the cells containing values to be used for calculation. Every formula in 
Excel begins with “=” sign. Let us now learn how to use these formulas in Worksheet. 
Creating Formulas using Constant Values: 
Constants are the numbers directly used in the formula. For example, if you want to add 
two numbers say 200 and 300. 

 Select the cell where result is to be displayed. 

 Enter the formula = 200 + 300 and press enter key or click ( ) button on the 
formulas bar. 

 The result 500 will appear in the active cell. 

 
The formula is crated using constants 200 and 300, any changes made in any part of the 
worksheet will not affect the result at all. 
 
 Creating Formulas using Cell Reference: 
Let write the value 30 in cell A1 and 40 in cell A2: 

 

button on the formula bar. 

 The result 70 will appear in the cell A3. 

 In this formula, rather than using values directly, the reference to those cells are 
used which contain value 30 and 40. That means the result is a sum of values 
stored at A1 and A2, So now, if there will be any change in the values of cell A1 
and A2 the result will be updated automatically. 
 
 

 



 

If you select the cell you want to use in a formula, by clicking it in the worksheet while 
creating the formula you have less chance of entering the wrong cell reference. 
Creating Complex Formulas: 
A complex mathematical expression in made up of more than one mathematical 
operator. In such types of formulas, operators are evaluated on the basis of their 
priority.  
The order of precedence for the mathematical operators in a complex expression is: 

 Exponent (^) 

 Division (/) and multiplication (*) 

 Addition (+) and Subtraction (-) 
 
For example the expression: 
=200/2*4^2+4-1 
Exponents operator (^) will be evaluated first as it has the highest priority in this 
expression. So the result will be: 
 = 200/2*16+4-1 (^removed) 
 
Next will be division (/) and multiplication (*) operators. As they but both stand at the 
next level, they will be evaluated as per their appearance in the expression from left to 
right. So the result will be: 
=100*16+4-1(/ removed) 
=1600+4-1 (*removed) 
 
Last will be Addition (+) and Subtraction (-) operators which being at the same level are 
evaluated as per their appearance from left to right. So the result will be: 
=1604-1 (+ removed) 
=1603 (- removed) 
 
This is how the results are calculated in complex formulation. 
But the priority can always be changed by keeping the part of expression which you 
want to evaluate first within the parenthesis. This means that anything which appears 
between the parenthesis is evaluated with the top priority. 
 



In this Example, 
The expression = 16+4/2 the result is 18. 
But the expression = (16+4)/2 will result 10 as in this addition operator (+) will be 
evaluated first with top priority. 
Operators at some level of precedence are resolved on the bases of their appearance 
from left to right in the expression. 
 
Copying Formulas to other cell: 
In Excel allows to copy the formula inserted in one cell to another and the cell reference 
used as an argument in the formula is updated automatically with respect to the new 
cell in which the formula is copied. 
 
Example: Now the worksheet given below: 
 

 
 
The cell F2 contains a formula = Sum (B2:E2) which calculates and insert the sum of 
three subjects in the total field. Now to calculate the sum of other three students, select 
the cell F2 containing formula in it. Keep the mouse pointer on the AutoFill handle as it 
turns to a ‘+’ sign and drag till F5. Release the left mouse button as you will notice the 
formula is copied to the cell F3, F4 and F5 automatically and the arguments are updated 
itself as they are referring to the corresponding ranges to show the sum of their 
respective row values. 
 



 
We can also use Copy and Paste method to copy the formula at some non-consecutive 
cell. 

 
 

Notice the change in cell reference. It is the way formula was copied from its source 
location. When the formula was copied from F2 to F3 the reference of the destination 
cell was changed within the same column but to the row, i.e., 3. So in the new formula 
argument range will also change like this =SUM (B2:E2), i.e., the column name will 
remain same and the row number will increment by 1. Likewise the formulas are formed 
for the other cells to show the sum of their respective values. 
Cell Referencing in the formula: 
Cell addresses used in a formula or as the function argument can be referred in the 
different ways depending on how do we want the values stored in those cells to be used 
for various calculations. There are three different ways by which we can refer cell values 
in our worksheet. Let us discuss these one by one. 



 
1. Relative reference: In the relative referencing, cell reference used in a formula 
changes with respect to change in the position of formula. This type of cell referencing is 
known as relative cell reference. This type of referencing is very useful in the situation 
when a similar formula is required to be entered in the consecutive cells for similar 
calculations. In this no special symbol is used with the cell address when using it as an 
argument in a formula. 
We assume that the cell A2 contains a formula = B2 + C2 + D2 and it is copied to another 
cell A6. The address will be changed =B6 + C6 + D6. 
 
2. Absolute Reference:  Absolute reference keeps the cell reference fixed in a formula 
irrespective of the change in position of that formula. Sometimes, you do not want to 
change the reference of a cell in a formula even if its position is changed in the 
worksheet. Such type of cells are required to be made absolute in the formula by adding 
a ($) dollar sign before the column name as well as row number in the cell address like 
$a$A1. Such type of cell reference the same even if the formula is copied to the other 
cells in the worksheet. This is known as absolute reference. 
For Example, The formula = $A$1 +$A$2 is an absolute cell referencing formula as its 
reference will remain same irrespective of its position in the worksheet. 
 
3. Mixed Reference: Mixed reference is a combination of absolute and relative 
reference as in this the cell reference change only one part of the cell address i.e., either 
row number or column name. In this type of cell reference only one part of cell address 
(either column name or row number) remains absolute while the other one relative. E.g. 
D$4 in this address the $ sign is used only with row number but not with column name. 
If this type of references is used in a formula then while copying the formula, cell 
reference changes only row wise or column wise which is relatively referred where as it 
remains the same when it is copied towards the part which is absolute.  This formula:  
=A$1 * 10 
As in this the $ sign is used before row number, i.e. 1, so when this formula will be 
copied along the column the cell address well remain same but when it will be copied 
along the row the address will changes accordingly. 
 
G. Chart in Excel: 
Charts are the graphical objects which represent the worksheet data in pictorial form. 
These are used to quickly analysis the data by representing it in different formats 
sometimes to analysis the data stored in a lengthy worksheet is very difficult and 
cumbersome job. A graphical representation of the data makes all these tasks easier. 
Moreover, performing different types of analysis on entries manually within the same 
worksheet is not an easy task. But a representation of data makes all these tasks easier. 
Different Types of Charts: 
The type of analysis required to be performed, different type of charts can be created, 
some of the most commonly used chart types are: 
1. Column Chart: The column chart is used to compare the values of two or more data 
items belonging to the same category. In this type of charts, categories are organized or 
represented horizontally along the X-axis and the values or data series are plotted 
vertically along the Y-axis is shown in figure. A column chart can be shown as stacked 
chart or 3D chart also. 



 
X-axis is the horizontal axis which is also known as category axis. 
Y-axis is the vertical axis which is also known as value axis. 
 
2. Bar Chart: A bar chart is just like a column chart used to compare the values of two or 
more data items except that in Bar Chart categories are organized vertically and the 
data items are plotted horizontally as shown in figure. 

 
3. Line Chart: A Line Chart represents the changing trends of the data over the time at 
equal intervals. These types of charts proved to be very useful when you need to depict 
the change of value over a time period, i.e., when the trends in the change of values are 
important.  
When the Y-axis indicates a quantity or percent and the x-axis represents unit of time, 
the line graph is referred to as a time series graph. 



 
4. Pie Chart: Unlike the other chart types, Pie chart is used to plot just the data series to 
represent the propositional size of one item to the sum of the items in the series. Each 
item is represented by one slice or pie of the whole chart. 
Be careful not to use too many segments in your Pie Chart. 
 

 
5. Rader Chart: In radar chart each data series has its own value axis from the center. A 
line connects all the values in the same data series. 



 
6. Doughnut Chart: Just like a Pie Chart, Doughnut Chart is also used to represent the 
relationship of a part to the whole. But unlike pie chart doughnut chart can represent 
more than one data series where in each series is plotted in the form of concentric 
circles. 
 

 

7. Scattered Chart: This type of chart is also known as XY Chart which is used to plot the 
data values using data markers in the XY plane. But unlike the Line Chart these points 
are not connected with any line. These types of charts are important when there are 
many points to plot but the trend among them is not very important. 



 
a. Creating Charts: 
MS – Excel provides a quick and easy way to create basic charts in your worksheet which 
can be further modified or formatted as needed. So once the data is entered in the 
worksheet, do as follows to shows it in the form of chart that you want to use. 

 

 

 Select the data in the worksheet, to be plotted including the column headers. 

 Click on Insert tab and in the Charts group click the specific chart category drop 
button and choose the required chart from the expanded list. 

 The chart plotted with the selected values will appear on the worksheet in 
default settings. 



 
 
The three chart tool tabs i.e. Design, Layout and Format added on the Ribbon. The 
options available in these tabs can be used to modify the default settings to meet the 
user’s needs. Let us now use them to customize the basic chart setting. 
 
b. Adding Chart Components: 
To make your chart more informative and easy to understand, you can add various chart 
components in your chart. We have selected the chart, to which you want to add 
components. Click Layout tab under the Charts Tools. 
 

 



 
 Click on Chart Title option in the Labels group and choose Above Chart option in 

it. A Chart Title text box will appear just above the plot area. Remove the existing 

text i.e.  Chart Title in the box and enter the suitable chart title in it. 

 



 

c. To add the Axis Titles: 

 Select Axis Title option in the Levels group and choose Primary Horizontal Axis 

Title  Title Below Axis. 

An Axis Title text box will appear below the category axis whose text can be replaced to 
enter suitable category axis title. 



 
To Add Title for the value axis or Y-axis. 
 

 Select Axis Title  Primary Vertical Axis Title  Rotated Title option in the 
Lables group. 

 An axis title box placed roated along the Y-axis will appear, whose text can be 
changed to enter y-axis title. 



 
 
To change the Legends Position: 

 If you want to change the location of legend box in the chart area which is 
displayed along the right edge, click on Legend button on the Lables group to 
choose the required position of the legends. 
If you want to remove the legends from the chart, choose None option in the 

expanded list. 



 
d. To Add Data Lables: 

 To show the data lables along the plotted bars, Click on Data Lables option in the 
Lables group and choose Show option in the expanded list. 
 



 
 
To add a data table of plotted values along with the chart, click on Data Table button in 
the Lables group and choose the option Show Data Table or Show data table with 
Legend keys. 



 
 
e. To Add Gridline in the Plotted Chart: 

 Select Grideline  Primary Horizontal Gridlines  Minor Gridlines (or the 
required option) in the Axes group to add horizontal gridlines in the chart. 

  
 
 



 
 
 
 
 
 
 
 
f. Moving, Resizing or Deleting a Chart: 
The embedded chart in a worksheet can be repositioned, resized or deleted like any 
other graphical object. 
 
Moving the Chart: 

 Select the chart by clicking on it. 

 Keep the pointer anywhere on the chart and drag it to the new location. 

 

Resizing the Chart: 
 Select the chart by clicking on it as the resizing handles will appear around the 

chart area. 

 Keep the mouse pointer on any of the resizing handle and drag inward or outward 

to resize the chart. 

 

Deleting the Chart: 

 Select the chart. 

 Press Delete or Del button on the keyboard as the selected chart will be deleted 

from the worksheet. 

 

Editing Charts: 
Sometimes after creating the chart, we feel the need of modifications like changing its 
type, data plotted or its layout. Excel provides easy to use tools to do these 
modifications in the chart. 
 
g. Changing Chart Type: 
To change and select some other chart type for your plotted chart. 

 Click on the chart to select it. 

 Choose Change Chart Type option in the Type group under the Design tab. 



 A Change Chart Type dialog box will appear as shown in figure. 

 Choose the suitable new chart type and its subtype in the dialog box and click OK 

button. 

 
h. Changing Data Source:  
If you want to change the plotted data range in your chart. 

 We have click on Chart to select it. 

 Choose Select Data option in the Data group under the Design tab, to open 

Select Data Source dialog box. 

 Click on collapse in the Chart data range box which is showing the current data 

range. 

 Select the changed data values to be plotted. 

 Expand the dialog box clicking the expand button and click OK button. 

 The chart will start showing the newly selected values. 



 

i. Printing the Worksheet:  
Excel worksheet containing formatted data charts or other objects can be printed to 
obtain hard copy output. We can print the selected part of the worksheet, complete 
worksheet or the entire worksheet. 
To print your worksheet: 

 

 We have to print only the data from the selected cells or worksheets to be 
printed. 

 Click on Print option in the MS-Office button menu. 

 Print dialog box will be displayed as shown in figure. 

 Select the Printer Name in the Pinter section. 

 Select the option for Print What section. 

 Selection: To print data from the selected range. 

 Active Sheets: To print data from the selected sheets. 

 Entire workbook: To print the entire workbook. 

 Choose the Print Range, i.e., the pages to be printed. 

 Enter the Number of copies to be printed. 

 Click OK button get the hard copy output. 



 



 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Practice Exercises: 
A. Fill in the blanks: 

1. An Electronic spreadsheet is the ……………………. Of the paper spreadsheet. 

2. …………….. worksheets are automatically generated on starting Excel. 

3. …………………. Contains the cell address of the active cell. 

4. For totaling of rows and columns type in the ……………….. bar. 

5. ………………. can take numeric as well as text data or level for numeric data. 

2. True and False: 

1. A Spread sheet is a sheet of paper with lines on it. 

2. MS Excel is windows based application. 

3. An Excel document is a worksheet. 

4. A Workbook is a collection of one or more worksheets. 

5. Data is entered in rows only. 

6. Excel dos not offer the multiplication and division calculations. 

3. Answer the following the questions: 

1. What is a cell? 

2. What is a workbook? 

3. What is a worksheet? 

4. What is a cell? What is cell address?  

5. How do you save the workbook? 

6. How do you adding new worksheet? 

7. What is a reference in a formula in Excel? 

8. How do you insert chart? 

9. Name the different types of charts? 

Answer the following questions: 
1. What are the different components of an excel worksheet? 

2. What is the difference between spreadsheet and electronic spreadsheet? 

3. Difference between Workbook & worksheet? 

4. How do you Modifying Cell Contents? 

5. How do you Replacing the Cell Contents? 

6. Short notes of Absolute, Relative and Mixed reference? 

  

1. Give the following answer with respect to spreadsheets: 

 Cell B2 Contains the number 7, and cell C2 contains the number 9. What 

will be the contents of cell D2 if the formula =B2*C2+2*SQRT(C2) is 

entered in the cell D2? 



 The contents of cell B2, C2, D2, and E2 are 7, 9, 12 and 8 respectively. 

What will be the value displayed in cell F2 which contains the formula + 

SQRT(EVEN(B2)/2*(C2-1)*D2^2*E2)? 

 Cell E3 contains the text “Happy Holiday” and the cell F3 contains the 

formula = RiGHT(E3,5). What will be the contents of the cell F3? 

 Cell E3 contains the text “Happy Holiday” and the cell F3 contains the 

formula =MID(E3, &, 5) What will be the contents of the cell F3? 

1. How do you insert a chart in Excel? 

2. Explain how do you save Excel workbooks? 

Practice Session: 
1. Make a new worksheet by the name of MARKS. Input the marks of 10 students in 

different subjects. The worksheet should contain S. No., Name, English, Maths and So 

Science as head. 

2. Create a new worksheet in Excel and enter the following data: 

 
3. Save the worksheet with the name SNACKS. 

4. Close the worksheet the quit Excel. 

 
 
 
 

 
 
 

 

 

 

 

 

 

 

 

 

 



                              UNIT-3 

                                      Advanced Power Point Presentation   

                                    

2.1 Introduction:  

Presentation is a collection of sequentially arranged slides put together in the 

form of a file. Microsoft PowerPoint is a software product used to perform 

computer-based presentations. There are various circumstances in which a 

presentation is made: teaching a class, introducing a product to sell, 

explaining an organizational structure, etc. 

"PowerPoint" refers to Microsoft PowerPoint, a program that allows the user 

to design a presentation that consists of multiple slides. These slides may 

contain images, text, video clips, and related types of information. 

PowerPoint is useful for delivering a speech, because the user can utilize text 

on the screen to remind him or herself of the information to be conveyed to 

the audience or to summarize his/her dialogue into more manageable and 

"friendly" sizes, as well as to entertain or explain graphs, charts, motion 

clips, figures, diagram and related data. Power point is excellent tool to 

convey the idea in an effective and interesting manner. 

Presentation in PowerPoint is collection of electronic slides containing 

information in the form of text, graphics, movie clips, sound etc. These 

slides are displayed in a sequential order one by one at the time of 

presentation on the monitor or projection screen with all multimedia and 

animation effects applied on them in the form of slide show. 

PowerPoint is not just used for creating electronic presentations but it also 

provide facilities to produce handouts, speaker notes, etc. which act as an 

effective tool during the presentation. 

Slides are the individual pages of the presentation containing information in 

a systematic manner. 

 

Starting PowerPoint 2007: 

Start PowerPoint just like any other component of MS Office which is as 

follows: 

1. Now Click Start button on the taskbar. 

2. Select All Programs. 

3. Choose MS Office option in the submenu. 

4. Click MS Office PowerPoint 2007 option. 



 



 
 

 
B. Components of PowerPoint Window 

1. Title Bar: Display the application name, file name and various window 

controlled like minimize button, maximize button and close button.  

2. Menu Bar: Different options for selection.  



3. Standard Tool Bar: Displayed by default, allows to give common 

commands like save file, open file, print etc.  

4. View Bar: This is used to change the view of the screen.  

5. The Drawing Palette: This is used to draw different shapes.  

6. Formatting Tool Bar: Allows the user to give commands related to 

formatting cells and cell contents like Bold, Font Size, Color, Style etc. 

7. Ribbon: The components are present just below the title bar. It has seven 

tabs in it wherein each tab is divided into the groups. The groups are the 

logical collection of features designed to perform various presentation 

related function. 

8. Slide Pane: This is the actual work area where individual slides are 

created or modified. 

9. Notes Pane: This is a small rectangular area under the slide pane which is 

used for typing the speaker notes for the individual slides. 

10. Slide/Outline Tab: These two tabs are present on the left side of slide 

pane which are used to perform slide related functions like inserting 

/deleting slides in the presentation, creating duplicate slides or to reorder the 

slides. 

11. View Buttons: This toolbar is present on the status bar at the bottom of 

PowerPoint window having three buttons, used to switch between the 

PowerPoint views. 

12. Mini Toolbar: This is a floating toolbar that is displayed, when you 

select text or right click on text. It contains formatting tools like Bold, Italic, 

Font, Font size, Color etc. 

1. Creating Presentation 

MS PowerPoint 2007 offers different ways to create a new presentation. 

These are: 

 

 Blank Presentation: You can use this method to create user defined 

presentation wherein you can add contents, format slides, apply 

effects of your own. This is the default way for creating presentations 

in PowerPoint. 

 Installed Templates: This is easiest way to create presentations on 

some general topics. PowerPoint offers a set of readymade templates 

suggesting the contents and design for your presentation. 

 Installed Themes: This option is useful when you want to use 

predesigned format for your presentation as the preset background, 

fontstyle,etc. are provided by PowerPoint. 



 
2. Views in PowerPoint: 

PowerPoint offers three different views to work with presentation slides. 

These are: 

1. Normal View: This is default PowerPoint view, used to create or modify 

the individual slides of Presentation. There are three different work areas in 

which this view is divided. These are: 

 Slide Pane:  This area is used to work on the current slide. It shows 

the large view of current slide with editable contents where you can 

easily modify or add the slide contents. 

 Notes Pane: This is a small rectangular area just under the slide pane 

which can be used for typing the speaker notes of the individual 

slides. 

 Slide/ Outline Tab: This is a tabbed area towards the left side of slide 

pane having two tabs in it. 

 Slide Tab: Shows the presentation slides in thumbnail mode. 

 Outline Tab: Shows the text components of each slide. 

 

These tabs are mainly used to perform slide related functions like adding, 

deleting or recording the slides. 



 
 

2. Slide Sorter View: This view shows all the presentation slides in their 

miniature form i.e. in their thumbnail view. You cannot add/edit contents in 

the slides while working in this view. You can use add/ delete or reorder the 

presentation slides. You can also apply transition effects on the slides in it. 



 
 

3. Slide Show View: This is a full screen presentation mode that allows you 

to show the presentation slides to the audience on full monitor/ projector 

screen with all multimedia animation effects applied on these. 



 
3. Designing the First Presentation:  

When PowerPoint presentation is started, a new blank presentation is started 

by default with a blank Title slide to be used as first slide of the presentation. 

You can add as many slides in your presentation as needed and can change 

their layout according to the contents you want to add on these. 

Slide Layout is a collection of various placeholders on a slide used to 

organize slide contents. 

To change the Slide Layout: 

 Click the Home tab and select Layout drop option in the slides group. 

 An expanded list box will appear, showing the various available slide 

layouts. 

 Click the required layout to apply it on the current slide. 

 

 



 
4. Adding Contents in the Placeholder: 

Each placeholder shows the instructors above how to add contents in it. To 

add graphical contents in a placeholder, you can use the icons present in it. 

To use a text placeholder: 

 Click inside the placeholder as the instructions displayed in it will 

disappear and a blinking cursor will appear inside the box to enter text 

in it. 

 Now enter the desired contents in it and once finished, click outside 

the box. The placeholder will disappear leaving the text positioned at 

the place. 



 

 
5. Adding a New Slide in the Presentation: 

To expand your presentation you can add new slides in your presentation 

and to do this: 

 

 Click the New Slide option in the slides group under the Home tab. 



 An expanded list of various available slide layouts will appear to 

choose the layout for your new slide. 

 A new slide will appear in the slide pane area along with the required 

placeholders.  

 Add the slide contents to finalize the slide. Like this you can add as 

many slides as needed to complete the presentation. 

 

Saving the presentation: 

We have completed of our presentation, you need to save it permanently in 

your system. Saving a presentation means saving all the slides present in it 

as a single file. 

To save your presentation: 

After the completion of your presentation. You need to save it permanently 

in your system. Saving a presentation means saving all the slides present in 

it as a single file. 

To save your presentation:  

 Click MS Office button and choose Save As option in the extended 

list. 

OR 

 Alternatively, you can click Save button in the Quick Access Toolbar. 

OR 

 Press Ctrl + S keyboard shortcut. 

 Save As dialog box will appear as shown in figure. 

 Select the storage location and give a suitable file name to your 

presentation. 

 Click the Save button. Your presentation will be saved with .pptx 

extension. 



 
 

B. Designing: 

Design templates are the predesigned styles for the slide element which can 

be applied to format the slide elements in a specific manner. 

Design template is a blank presentation with formatting, a color scheme and 

sometimes graphics already applied on it. For using designs make your 

presentation. 

 Now Start MS POWERPOINT 2007. 

 Click the MS Office button and then click New option in it. 

 In the left Pane of New Presentation window select Installed Themes 

option. Templates loaded on your computer appear under the 

Installed themes section. 

 Scroll through the list to select the template to be used for the 

presentation. 

 Click create button on the dialog box or just double click the selected 

theme. 

 A new presentation with title slide opens on your screen in Normal 

view 

 



 
 



 
 Now just like using Blank Presentation mode you can add contents 

on the slide. The slide which you will add to the presentation will 

automatically appear in the selected design.  

 



 
D. Manipulating Slides: 

Working with Text in a Presentation slides: 

In PowerPoint Text constitutes an important part of your presentation slides. 

The text on the slides is added using various placeholders having a preset 

default format. PowerPoint provides various text related functions that can 

be used to modify the added contents like copying, moving or deleting them 

in slides or to change the default format for making it more effective and 

presentable. 

1. Modifying the slide text: 

Like in other applications, you can use basic text editing features like 

copying moving or deleting, very easily in the PowerPoint slides also. 

To copy text: 

 Select the text to be copied. 

 Click Copy Option in the clipboard group on the Home tab or Press 

Ctrl +C keyboard Shortcut. 

 Bring the cursor to the new location where text is to be copied. 

 Click Paste option in the Clipboard group or Press Ctrl +V keyboard 

shortcut. 

The selected text will appear at the destination. 



 
To Move Text: 

 Select the text whose position is to be changed. 

 Click Cut option in the Clipboard group on the Home tab or Press Ctrl 

+ X keyboard shortcut. 

 Click to select the destination where text is to be moved. 

 Click Paste option in the Clipboard group or Press Ctrl + V keyboard 

shortcut. 

The selected text will appear at the new position. 

2. Formatting the Slide text: 

Text entered in the slide using various placeholders appear with the default 

format as set to show the text in it. PowerPoint offers wide variety of 

formatting features that can help you to change the default formats as per the 

need of your presentation. 

Using Font Group:  

You can use the options provided under the Font group on the Home tab to 

change the text attributes. 

 Select the text on the slide whose format is to be changed. 

 Use Font List box to change the text style. 

 To change the text size or text color you can use Font Size or Font 

color drop buttons respectively. 

 Special formatting like Bold, Italic, Underline or Shadow can be 

applied using respective options available in the Font group. 

 
Aligning Text: 

Alignment refers to the placement of text with respect to the placeholder 

boundary. Text within a placeholder can be aligned to left, right, center or 

justified as follows: 

Using Paragraph Group 

 Select the text or placeholder whose text has to be aligned. 



 Click the required alignment option from the group of four buttons 

available on the Paragraph group under the Home tab.  

 
 

 

Using Bullets and Numbering: 

In most of time, to display the list of topics covered on a slide we use to 

create an ordered or unordered list depending on the way we want to show 

these topics. 

To create an Ordered or Numbered list: 

 Click in the Text Placeholder. 

 On the Home tab, click Numbering drop button in the Paragraph 

group. 

 Select the numbering style from the extended box to start the list. 

 The numbers will be added automatically to the entered topics or 

items in the ascending order. 

 
 

As similarly, if you want to create an unordered or bulleted list of items or 

topics, you can use the Bullets drop down to select the bullet style to be used 

for marking each item of the list. 

 

 

3. Changing Slide Background 



Our presentation slides by default have white or no background. But 

PowerPoint provides different styles of background effect like colourful 

background, patterned background, graphical background or textured 

backgrounds to give an attractive look to your presentation. 

To change the slide background: 

 Select the slides whose background has to be changed. 

 From the Design tab in the Background group click the Background 
Styles drop button to expand the box. 
 

 
 

 You can choose the predesigned background from the expanded box 
by simply clicking the required style. 

 To get more background option, click Format Background option in 
the expanded box. 

 Click Fill option on the left side of Format Background dialog box. 
From the right side choose an option out of the following: 



 
 

o Solid Fill: To use single color background. 
o Gradient Fill: To use multicolored background. 
o Picture Texture Fill: To add a designer background which could 

be an image sored in the system or a predesigned texture. 

 As per the selected option, choose the required background color or           
graphics. 

 In case of a picture background, browse the image in your system or 
you can use clipart image. 

 Click Close button to apply the selected background to the current 
slide. If you want the selected background to be applied on all the 
slides, click Apply to All buttons. 

 

 



 
Figure - Color Backgroud 



 
Figure - Gradient Background 



 
Figure - Texture Background 

4. Applying a Theme 

When you create a presentation using a template or a readymade design, it 

includes a theme i.e. a combination of colors, fonts, formatting’s, graphics 

etc. 

You can change the existing t of your presentation follows these steps. 

 Select the slide to which the new theme is to be applied. 

 From the Themes group on the Design tab choose the required 

theme. Live preview feature will keep on showing you the current 

slide with the pointed theme. 



 
 Right click on the thumbnail to be applied and choose the option 

Apply to Selected Slides. The chosen theme will appear in the 

current slide. 

 You can simply click the theme thumbnail, if you want to apply it on 

all the slide of your presentation. 
 

 

 

E. Adding Graphical Objects to the slides: 

In Graphical Objects like pictures, clipart’s, shapes, figures, etc. play a very 

vital role while designing a presentation. They not only just make the slides 

attractive but also help the presenter to express his core idea behind the slide 

or the presentation as it is rightly said that ‘A Picture is worth a thousand 

words.’ 

 

 

1. Inserting a picture or ClipArt: 

We can insert a ClipArt or Picture stored on your computer in the 

presentation slide as follows: 

To Insert ClipArt: 

 On the Insert tab in the Illustrations group, click ClipArt option. 

 In the ClipArt task pane, enter the word or phrase that best 

describes the ClipArt you want to add on the slides in the Search for 

text box. 



 To narrow your search, choose the collection from the search in drop 

box. If you want to get only clipart images then from the Results 

should be drop box uncheck rest of the options except ClipArt. 

 Click Go button or press Enter key. Clip Arts will appear in the task 

pane. 

 Now click the ClipArt in the result list to insert it on the slide. 

 

 

2. To Insert a Stored or Downloaded Picture: 

 Click where you want to insert the picture. 

 On the Insert tab, in the Illustrations group click Picture option. 

 An Insert Picture dialog box is displayed as shown in figure. Locate 

the picture in your system that you want to use and then double click 

it. The selected picture will appear on the current slides. 

 



 
 



 
3. To Add Shapes: 

Shapes are the predesigned complex figures that can be created easily on the 

PowerPoint slides. 

 Click on Shapes option in the Illustrations group on the Insert tab. 

 The expanded box shows the various shapes categories like lines, 

basic shapes, arrows, stars, banners etc. 

 Click the shape which you want to draw on your slide. Your pointer 

will turn to a crosshair shapes. 

 Now click on the slide where you want to draw the shape and then 

drag to create the figure. 

 



 
 

 

 

Modifying Shapes: 

The inserted shape can be modified by changing its line color, fill color or 

by adding special effects like 3D or shadow. 

To change the shape format: 

 Select the shape by clicking on it. A Format tab will appear on the 

Ribbon. 



 

 
 Click on Format tab. From the Quick style group, click the Shape 

Outline drop button choose the Line Color from the expanded box. 

 
 We can use Weight option in it to change the line thickness. 

 Using Shape Fill drop button in the Shape style group choose a color, 

picture, gradient or pattern to be filled inside the box. 



 
 

 To add special effect; click the Shape Effects drop button and choose 

the effect from the available options like Shadow, Reflection, Glow, 

Soft edges, Bevel (3D) or 3D-rotation as needed. 

 

4. Adding WordArt:  

The Word Art is a decorative text that can be added on the slide as a text 

object. You can use this feature to create fancy slide title or to visually 

enhance the text which you want to specially highlight in your slide. 

To add WordArt: 

 Click the Insert tab and in the Text group, click WordArt drop option. 



 The WordArt gallery opens, displaying a list of style as shown figure. 

 
 We required the WordArt effect from the expanded box. Word Art 

objects in the slide with the placeholder text formatting appear on 

the slide, showing text, Your Text Here. 

 
 With the placeholder text selected, type the text to be shown in that 

format. 

 Move the placeholder to the location where you want to place that 

text. 



 
 If you want to modify the WordArt text format, select the WordArt 

and using options available in the WordArt Style group on the 

Format tab, you can make these changes. 

 

5. Working with Slide Sorter View: 

Slide presentation is ready, we can review or modify the placement of slides 

in the presentation and if we needed, you can also insert or delete slides from 

the presentation using Slide Sorter view. In this view the slide displayed in 

the miniature or thumbnail form, as it does not allow you to modify or add 

contents in the slide. To switch into Slide Sorter view, click the Slide Sorter 

button on the status bar or select view tab and click Slide Sorter button on 

the Presentation views group. The PowerPoint view will change as shown 

in figure.  



 
Rearranging Presentation Slides: 

We can change the slide order as follows: 

 Click and select the slide which is to be repositioned. 

 Hold the left mouse button and drag it to position the slide pointer 

where the slide has to be moved. 

 Release the left mouse button to reposition the slide at the new 

location. 

6. Inserting a New Slide: 

Multiple slides can be selected using Ctrl or Shift key. To select consecutive 

slides use Shift key and for non-consecutive slides you can use Ctrl key. 

We can add a slide in your presentation you can do it by selecting its 

position, where it is to be inserted. 

 

 



 Select the slide thumbnail in the slide sorter view after which the new 

slide is to be inserted. We can also select multiple slides, if more than 

one slide is to be inserted. 

 Click New Slide button in the Slide button in the slides group on 

Home tab and choose the required slide layout from the expanded 

box. 

 A blank slide will appear next to the selected slide. 

Alternatively, we can also press Ctrl + M keyboard shortcut to add new slide 

with default layout. 

Deleting a Slide: 

 

We want to delete some unwanted slide from the presentation we can do it 

like this: 

 Select the slide to be deleted. We can also select multiple slides, if 

you want to delete more than one slide. 

 Click Delete button in the slides group on the Home tab or simply 

press Del/Delete key on the keyboard. 

 The selected slides will be removed from the presentation. 

 

We can also perform many other applications like adding slide transition 

effects, slide timing, etc. 

 

F. Animating Slides: 

Animations are the special visual effects used which make your electronic 

presentation more attractive and interesting. Using these affects you can 

emphasis or highlight the important points and the control their appearance 

on the slide, when needed during the slide show. Animations can be applied 

to the individual slide objects like text, images, word art, shape, chart etc. 

and they can also be used during the slide transition i.e. while switching 

from one slide to another. 

1. Animating Slide Objects: 

Object based animation effects are used for emphasizing or controlling the 

way they enter or exit from the slide. 

To Animate the Objects on the slides 

 Click and select the object to be animated in the slide pane. 

 Choose Custom Animation option in the Animation group on the 

Animation tab. A custom animation task pane will appear as shown 

in figure. 

 Click Add Effects drop button on the task pane to choose the type of 

animation from the options Entrance, Emphasis, Exit or Motion path. 



 
 

 An extended list of effects available under the selected category will 

appear. 

 Choose the effect of your choice, keeping the Auto Preview option 

checked in the task pane. 

 The added effect will get listed in the Custom Animation task pane. 



                   

 

 



 Repeat the process for the other objects also to add required effects. 

 Once the effects are added, click the play button at the bottom of the 

task pane to preview all the added effects as each one of them will 

animate one after the other in a sequence they appear in the custom 

animation task pane. 

2. Modifying Animations: 

We can also modify the animation setting settings according to need of your 

presentation. 

To add enhancement to the animated object: 

 Select the object on the slide whose animation effect is to be 

modified.  

 In the custom animation task pane, right click on the applied 

animation and choose Effect Options from the shortcut menu. 

 Effect dialog box will appear as shown in figure. 

 Click the Effect tab in it. 



         

 
 

The Enhancement section: 

 Select a sound that is to be played during the animation. 

 To change the object color or to hide the objects after animation, 

select from the After Animation drop box. 

 IF the selected object is a text then choose the option as how do you 

want the text to appears, All at once, by Word or by Letter. 

 Click OK button to apply the settings. 

Changing Animation Speed: 

In the Slide show the time taken by the object to complete the animation is 

called Animation Speed. If you want to change the default animations speed: 

 Select the object whose speed is to be changed. 



 In the speed drop box of the Custom Animation task pane, choose 

any of the following option: 

o Very Slow (Take 5 seconds to complete). 

o Slow (Take 3 seconds to complete). 

o Medium (Takes 2 seconds to complete). 

o Fast (Takes 1 second to complete). 

o Very Fast (Takes 0.5 seconds to complete). 

 
Reordering the Animation Sequence: 

The objects on the slide are animated as per the sequence in which they 

appear in Custom Animation task pane. If you want to change the order: 

 Click and select the animation in the task pane. Hold down the left 

mouse button and drag it to the new position in the list or After 

selecting the animation in the list use Up or Down Re-Order button 

at the bottom of list to change its position. 

Removing the Applied Animation: 

If we want to remove the applied animation from an object: 

1.  Select the object on the slide whose animation is to be removed. 

1. Click Remove button in the Custom Animation task pane to remove 

that effect. 

3. Slide Transition: 



These are the special animation effects which are applied on the slides and 

are used to introduce the slide during the slide show in an animated manner. 

We can make slide to fade out into the next slide or the upcoming slide 

covering up the previous slide. There are many such transition effects 

available in PowerPoint 2007. 

To apply the Slide Transition: 

 Select the slide to which you want to apply the transition effect. 

 Select an effect from the Transition to This Slide group under the 

Animation tab as the live preview of the selected effect will appear 

on the slide. To see more transition effects, click the More button.  
 

 

 

 I
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ou want to apply the same transition effect on all the slides of your 

presentation, click Apply to All buttons in the Transition to this Slide 

group. 

 To apply a sound effect along with the transition, select a sound from 

the Transition Sound drop list box. 



                                     

   
Adding Action Button:  

Placing an action button on a PowerPoint slide gives you a way to view your 

presentation in any order, play sound or video clips and more. 

To add action button on a slide: 

 Open the Insert tab on the ribbon and click the shapes drop button 

on the Illustrations group. 

 From the expanded box, under the Action Buttons category, select 

the action button shape that you want to create. 

 Now draw the button on the slide by dragging it at the desired place. 



 Action Setting dialog box will appear as shown in figure along with 

the default button setting selected in Hyperlink to: box If you want 

to set some other action you can choose from drop box. 

              

 
 We can also select a sound to be played when using the button. 

 Click OK button. 

6. Slide Show: 

Slide show is one of the PowerPoint view which shows the presentation 

slides on full screen mode with all the animation and sound effects used in it. 

The show can be either controlled manually by the presenter or it can be 

timed for automatic execution. There are many different ways, used to 

launch slide show like: 



 Click Slide Show option in the Presentation View on the View tab Or 

Click Slide Show button in the Views toolbar on the status bar or 

Press F5 function key on the keyboard.  

We can also use the options available in the Start Slide Show group on the 

Slide Show tab like. 

From Beginning: To start presentation from the first slide irrespective of 

the current slide. 

From Current Slide: To start presentation from the currently selected slide. 

 
Rehearse Timings: 

Rehearse Timing is used to record the slide timings for the slide show. The 

option can be used to estimate or record the timings for each slide which it is 

going to take at the time of slide show. This is an interactive way of 

recording slide timing as the timing are recorded live while playing the 

presentation. To record timings: 

 

 

 



 

 Rehearsal Toolbar is displayed as shown in figure with buttons like 

Next, Pause, Repeat, etc. Click Next button when the current time 

clock shows the time required for the slide. 

 Continue like this till the end of presentation. At the end a dialog box 

appears, showing the total presentation time. 

 If you want to use the recorded timings for presentation, click Yes 

button. 

 

G. Inserting Movie or sound in the presentation: 

We can also insert a stored movie or sound clip in the presentation slides 

using clip organizer or from the saved clips. 

To Insert a Video Clip 

 Click Video drop button in the Media Clips group on the Insert tab. 

 From the expanded list, choose the option Video from File. 

 Insert Video dialog box is displayed. Locate the movie clip to be 

inserted from the system and click OK button. 

 



 

 
 

 A dialog box will appear asking how to do you want to play the 

movie; manually or automatically. 

 Select the option as needed. 

To Insert a Sound Clip: 

 Click Sound drop button in the Media Clips group on the Insert tab. 



 

 

 
 

 From the expanded list, choose Sound from File option. 

 Insert sound dialog box is displayed as shown in figure. Locate the 

sound file to be inserted. Click Insert button. 

 A dialog box asking how you want to play the sound will appear. 

Choose the option needed. 

 

 

 

 

 

 

Printing a Presentation: 

The Presentation created in PowerPoint can be printed just like any other 

office file. We can print all or selected slides, handouts or speaker notes of 

the presentation. 



 To print the presentation:  

 Select Print option in the MS Office button and choose Print option 

in the cascading menu. 

 Print dialog box is displayed in figure. 

 Select the name of printer to be used for hard output. 

 From the print range choose the option All, Current Slide or Selection 

for specific slides to be printed. 

 If multiple copies are to be printed enter number of copies to be 

printed. 

 Click OK button to start the printing. 

 

 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Practice Exercise: 

Fill in the blanks: 

1. ……………. Is short cut key for pasting the cell contents? 

2. PowerPoint is a software to make ………………………………….. 

3. Slide number is displayed in the …………………. Bar. 

4. …………….. is a collection of sequentially arranged slides put 

together in the form of a file. 

5. ……………………. a presentation means saving all the slides present 

in it as a single file. 

State True or False: 

1. You can use the documents of Word in PowerPoint. 

2. Shapes are the predesigned complex figures that can be created easily 

on the PowerPoint slides. 

3. You can open an existing presentation from the opening pane of 

PowerPoint. 

1. The Clip Art is a decorative text that can be added on the slide as a 

text object. 

2. Our presentation slides by default have white or no background. 

3. You can use add/ delete or reorder the presentation slides. 

Answer the following questions: 

 

1. What is PowerPoint? What does PowerPoint do? 

2. How do you apply a shadow to text? 

3. How do you insert a clipart in PowerPoint? 

4. How do you insert a new slide in PowerPoint? 

 

Answer the following questions: 

1. How do you new presentation using templates? 

2.  What is slide sorter view in PowerPoint? 

3.  Name do you different types of charts you can be inserted? 

4.  How do you add graphic objects, audio and video to slides? 

5. What is a watermark in PowerPoint? 

6. How to add Word Art? 

7. How to delete a slide? 

8. How to printing a presentation? 

Lab Activity: 

 Make the different-different type presentation 

 

 


